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Advance Your Knowledge

Why Budget?

A budget forces you to...
* Map your goals for the future
* Tracks your progress
* Motivates staff and leadership
* Provides confidence in the staff and leadership for the members
* Meets the organizations objectives

* Avoids over-expenditure and debt

MB
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Types of Budgets

* Incremental-based — Current year’s budget is used as a basis for next year’s budget
with a fixed percentage (+/- 2%) added or subtracted.

* Zero-based — Every program starts at zero dollars and each ministry determines and
justifies what it needs to spend.

* Modified base — All programs are evaluated and funded based on their potential. Staff
needs to plan programs before preparing the budget. This is when you might use
Revised Budgets instead of editing.

* Pledge-driven — Annual pledges determine the overall total budget.

Some additional tips for Budget Planning

MB
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Advance Your Knowledge
Setting up the New Year

* The process starts when you create a new year.

* General Ledger > Modify > Year and Periods > Click Add New Year.

APP atio e anage e Reports oQ filitie

Home > General Ledger > Year Period

Add New Year
% * Begin Date = * EndDate [N |

* Number of Periods Include Audit Period? [ Is Year Closed?

MB
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Setting up the New Year

Home > General Ledger > Year Period
* The assumption is you want
* BeginDate [ |EB “EndDate [ |Em
a 12-month period, * Number of Periods | 12 Include Audit Period? ) s Year Closed?
. . . Note
beginning on the first day of
the next Calendar or Fiscal
Year.
* Uncheck the box if you don't Period Information Closed?
1 [July [m] 7 [January O
H H \ugust abruary
want to include an Audit L S L (i
3 September O 9 March O
; 4 [October 0w D
PerIOd' 5 [Nevember O " [May m}
. 6 December (] 12 |June (]
* Click Update. Aud 0
-- MB




Advance Your Knowledge

Setting up the New Year

* You have the option to copy

from the prior year (most Home > General Ledger > Year Period

common), another company Set up account structure and accounts for

or fiscal year, templates, or

start over from scratch (do
not copy).

Copy From ® Year
O Another company or fiscal year
O Templates
© Do not copy. Create manually

Copy Budgets?

> The option to Copy Budget [ Update [SUR

from prior year.

* Click Update.

10/18/2023
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Manually Enter Budget

* Change your Financial

Home > General Ledger > Budget Information

Settings to the new budget

Filters

year! — -
Fund Name 1|Q Church
© GenEraI LEdger > MOdlfv > ' Department Name | 301(1 Genl Operations
Budget Information ik

Budget Revisi :O Original v\

* Enter in the levels in your

Show Inactive Accounts [

Chart of Accounts (they may [ searcn [ENRPRIN

differ from this example

based on your structure).

* Click Search

MB



Advance Your Knowledge

Manually Enter Budget

* Click on either the edit pencil or click on the amount to change the amounts.

[

#

[4

;Se ected g Account History Column Option

fi D \ Account? Name Account Type  Distribution Type  Current B% History VB Note

d O m 52110 Accountant/Audit Expense by Period il%ﬁ)ﬂ LD O i

i O 2 52115 Advertising/marketing Expense by Period $9,600.00 o (]

f O m 52130 Bank Fees Expense by Period $300.00 LD O b

H O Computer Supplies Expense Annual $1,800.00 o O 1
O m nsurance-property & liability Expense by Period §13,500.00 LD O 1
0O Legal Fees Expense by Period $1,200.00 s O J

e, 5 oy e _m, =

10/18/2023
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Manually Enter Budget

Home > General Ledger > Budget Information > Update
* Click on the Edit pencil to access more pR——
Distribute Budget
options to budget by... B
Dera Arraq DY Prior Budget %
—_— by Defined % I
* Annual
= e
Buaget
° Period $0.00] 000
$0.00 000
* Prior Year % o
October 0.00
* Prior Year Budget % . 2o e
December $0.00 0.0
* By Defined % e [san) g
February $6.000 0¢ 50.00
Mar $0.00
Aps $0.0 000
N $0.0
Jure $0.00 0.00
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Advance Your Knowledge

B A I Home > General Ledger > Budget Information > Update
y n n u a Account 50150 Facilities
Distribute Budget
* Divide Annual Amount by 12 months. finnual fmacnt
DetaiLs ATTACHMENTS NoTe
* Good for costs that don't vary by period

Period Current Budget Rounded % of

Budget
July $7,500.00 233
August $7,500.00 833
September §7,500.00 833
October $7,500.00 833
November $7,500.00 £33
December $7,500.00 833
January $7,500.00 833
February $7,500.00 833
March $7,500.00 833
April §7,500.00 833
May $7,500.00 233
June $7,500.00 833
Totals $90,000.00 100.00

[ oo [ MB
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Advance Your Knowledge

Home > General Ledger > Budgel Information > Update

By Period e, bt
Distribute Budget [by Period v
Annual Amount $11.150.00
° Budget by Period when expenditures T B
are expected. = P
Budget
July [ s1.100.00] 987
August 11 0 7
* It helps to identify periods where the j:e riz'iuzg%: 98
available money may not cover iz T oo
November [ $900.00] 807
expenses. December [ $800.00) 747
January [ $800.00] 717
February [ s7s000) 673
March [ss0009 7
April [ sso0.00] 207
May [ st.00000] 897
June [ s1.10000] 987
Totals $11,150.00 100.00
: MB
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Prior Year %

10/18/2023

Advance Your Knowledge

Account 40110 Offering-Tithes/pledg Account 40110 Offering Tithes/pledge
Distribute Budget Distribute Budget
DetaiLs ATTACHMENTS Note Derais ATTACHMENTS Nore

Period Current Budget | Rour| Period Current Budget  Rounded % of Prior 1
Budget Actual

July §16,666.63 July $26,397.32 1320 52504726
August $16,666.67 August $13,69897 635 §1299836
September $16,666.67 September $14977.29 749 $14211.30
October §16,666.67 October §15,80094 790 §15,00136
November $16,666.67 November §15,51562 776 $14722.10
December $16,666.67 December §21,34259 1067 52025200
January $16,666.67 January $21207.63 1060 $20,123.00
e $16,666.67 February $15019.13 751 §14251.00
March $16,666.67 March $14,230.82 742 $13503.00
April $16666.67 April $14,742.17 737 $13988.20
May $16666.67 May $14,491.66 725 §1375050
o S16.666.67 June $12,565.6 628 §1192320
s $200,000.00 Totals 5200,000.00 10000 $189,771.28

12

This distribution takes the
actual percent of
expenditures by period from
the previous year and applies
the same percentage to the
correlating period of the
current year.

This saves time and
calculations.

MB
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Prior Year Budget %

Account 40110 Offering-Tithes/pledge Account 40110 Offering-Tithes/pledge
Distribute Budget Distribute Budget

Annual Amount o Annual Amount (1}

DETAILS ATTACHMENTS Note DeTaILS ATTACHMENTS Note
Period Current Budget  Rounded % of Period Current Budget  Rounded % of Prior 1
Budget Budget Budget
July §16,666.63 £33 July §1111112 556 $10000.00
August $16,666.67 833 August $11111.11 556 $10000.00
September $16.666.67 &1 September §1333333 667 §12,000.00
October 316,666.67 FEE) October $15,555.56 778 $14,000.00
November 51666667 £33 November §13.888.80 944 $17,000.00
December $16,666:67 533 December 2222222 i $20,000.00
January §16,666:67 833 January §2222222 IR} $20,000.00
- $16,666:67 833 February $20,000.00 10.00 $18,000.00
March §16,666.67 a3 March 1944084 o72 §17,500.00
Aol $16.666.67 oo Agril $13888.89 944 $17,000.00
May 41666667 o May §16,111.11 £06 §14,500.00
o $1666667 o June $11111n 5.56 $10,000.00
Totals T 100,00 Totals $200,000.00 100.00  $180,000.00

13
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Advance Your Knowledge

 This distribution takes the
actual budget percent by
period from the previous year
and applies the same
percentage to the correlating
period of the current year.

MB
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Advance Your Knowledge

By Defined %

* This distribution calculates the period
budget amounts by dividing the total
annual budget by the defined percent

you enter in the proper period

14

Account 60520 Insurance

Distribute Budget | by Defined % A
Annual Amount $227,500.00

Detans ATTACHMENTS Note
Period Current Budget % of
Budget
July $0.00 0.00]
August $000 0.00
September §56,875.00 [ 2500
October $0.00 0.00]
November $0.00 0.00
December $56,875.00 [ 25.00
January $0.00 0.00
February $0.00 0.00]
March §56,875.00 25.00
April $0.00 0.00
May $0.00 0.00]
June $56,875.00 25.00]
Totals $227,500.00 100.00

10/18/2023

MB
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Using the Budget Import/Export Option

* Click on Import/Export Budget
* Enter by Annual or By Period

Home > General Ledger > Budget Information RO acdmombu
Filters 5
CJ View Selected Account History Column Options

C Accounts Name Account Type Current Budget Hastory ve Note
o 7 |0 Offering-Tithes/pledge ncome o] (u]
(w " | 7 o0 Offenng-Tithes/nonpledge Income o O
)} /om0 Otering-Plate/loose cash income o (u]
Ol /w0 Building Campaign Income. (o} (m]
=" i Offering-non cash/stocks yicome o o
oW 7 Tes ncome Annus o o
oW 7/ Facity Use Income-Outside Groups ncome Annual (o} o
oW Ve Pension income income Annual on O
o @ 7 Facity Use Income-Schaal acome Annua o ]
(ml | /s Interest Income. Income Annual o (]
a| oW |/ e et romne T Al o) 0
O 7 a0 Ganlozs on sale of ivestments Income Annoal o) u]
oW 7/ %0 McLean Income ncome Annual (o} 0

wia) [ Ry pogesie|100 +

— | mrortExpon Budget

MB
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Advance Your Knowledge

Export to Excel

10/18/2023

» Before your fiscal year begins open the new year and make any needed chart of account changes.

* Then Export the budget into Excel and navigate through your budget process.

Select the Levels from your Account Structure to Export|

Selectio:ﬂ none

v]Addnew [ Save || Delete |

= All

R 1 First Church of the Resurrection

s, PN -

MB
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Export to Excel

* After the budget is complete in Excel, import it back into your new year.
* If you added any new accounts in the budget process, make sure you add those accounts into GL

before importing.

Select the File to use for Importing the Budget. Valid file extensions are 'xls’ and "xIsx’.

File Name | Choose File | No file chosen

| Import |cancel

ey PP Y

MB
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Advance Your Knowledge

Attachments and Notes

Home > General Ledger > Budget Information = Update
Account 50160 Nursery
Distribute Budget | Annual v
* Attach by account important documents or Aenst Amount [ 515,600.00]
. P Derans ATTACHMENTS oTE
notes to explain unusual budget activity. o |
[ Done [RA.
[ V4 ) raciities Expense Annual 340, UUUL L1 I
O 2 so Nursery Expense Annual $15,600.00 9 O L’[é
[l Z ] Weddinns Eynense b Darind 4730000 Fiv] [

18
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Advance Your Knowledge

Closer look at the Budget Grid

Click on the
Graph to see
current and prior
year comparison
for Budget and
Actual

000000000 O0OONELRD

ey

El E E E E E E E E E E EF]El

Legal Fees

Office Supplies

10/18/2023

e T S I e e

$4,000.00
$3,500.00
$3,000.00
$2,500.00
$2,000.00
$1,500.00
$1,000.00
$500.00
$0.00

52250 Office Supplies

0202/T/L

6TOZ/T/L

Budget
Actual

19



Advance Your Knowledge

Closer look at the Budget Grid

* Click on Account History Column
Options.

Account History Column Options

ry VB Note

* Choose from the Available
Options the number of years
Actual, Budget and % or $

Variance Columns.

20

Available Options:

Selected Options:

Current Variance (3)
Current Variance (%)
Prior 1 Budget
Prior 2 Budget
Prior 2 Actual

Prior 2 Variance ()
Prior 2 Variance (%)
Prior 3 Budget
Prior 3 Actual

Prior 3 Variance ()
Prior 3 Variance (%)
Prior 4 Budget

Current Actual
Prior 1 Actual
Prior 1 Variance ($)

Prior 1 Variance (%)

10/18/2023

MB
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Advance Your Knowledge

Closer look at the Budget Grid

* Click on the Icon to ~
Period Current Budget Current Actual Prior 1 Prior 1 Prior 1
see the detailed I R
g History July

History of any Income o Fres =
or Expense Account. Septeber 900
October 0.00
November 44999
December 0.00
* Great research tool! January 6562
February 7 200. (82 ) ($291.67) -937
March $0.00 (§266.67) 000
Apnil $200.00 $0.00 (§266.67) 0.00
May $0.00 $0.00 (5266.67) 0.00
June $700.00 $0.00 ($266.67) 0.00

Totals $3,200.00 $1,500.00 $2,550.00 (5650.00)

MB
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Budgeted Financial Statement

* This report is the most versatile and flexible report for those with budgets. The columns can be
reordered, renamed or replaced based on the recipient of the report. Budget, actual andupto 5

prior years information can included.

Budgeted Financial Statement for Period 1 - January 8.33%

Company#: 1 Hame: First Church of the Resurrection

Fiscal Year Beginning 1/1/ams

Fund Name: 1 Church Operations / Department Name: 150 Administration

Account #

Description i1 Annual Budget JliActual YTD [l Annual Budget SiEMActual YTD  periAnnual Budget Bl LActual YTD
Administration Expenses
52110 Accountant/ Audit 0 .00 .00 00 .00 .00
52180 Insurance .00 150.00 10,000.00 .00 .00 .00
52190 Internet Access 00 .00 00 .00 .00 .00
52200 Kitchen Supplies 00 .00 00 .00 .00 00
52210 Legal Fees .00 362.50 .00 .00 .00 .00
52220 Marketing 00 50.00 .00 00 .00 00
52250 Office Supplies .00 .00 .00 456.00 .00 .00
52270 Postage .00 .00 .00 .00 .00 .00
52280 Printing .00 191.38 00 23417 .00 00
52300 Small Equipment .00 .00 .00 .00 .00 .00
52340 Supplies 00 .00 00 .00 .00 00
52350 Technology-Equip Maint .00 5,145.92 .00 .00 .00 .00
52360 Technology-SoftwarE .00 <00 .00 .00 .00 00
52370 Website 00 .00 00 .00 .00 .00

Total Administration Expenses .00 5,899.60 10,000.00 690.17 .00 .00 M B

22



23

Advance Your Knowledge

Modify Budgeted Financial Format

* GL > Modify > Budgeted Financial Formats

* Tide (Shestry Standard templates annot be eoned)
Passanard bor Charges retype
Avadable Columns. Selected Columns

Coboman eader (anomie) Oemrsgmren

D de i 1 poges

For more info on creating or editing Budgeted Financial Formats

10/18/2023

MB

23


https://ministrybrandshq-my.sharepoint.com/:b:/g/personal/mark_crain_ministrybrands_com/EYblY9oxUSJCl_wuSALHufgBeZAkFT-_S0cLJEjkPU7zpg?e=Gb0Dsu

Modify Budgeted Financial Format

Account Information

Available Columns

= Account Information
Account Number
[ Account Number With Description

~ Description

Current Year Fields

Up to 5 prior year fields

24

= Current Year

Current Year - Actual for Period
Current Year - Actual YTD

Current Year - Actual Annual

= Current Year - Budget for Period

Current Year - Budget YTD
Current Year - Budget Annual

Current Year - Revised Budget for Period

= Current Year - Revised Budget YTD

Current Year - Revised Budget Annual
Current Year - Debits for Period
Current Year - Debits YTD

Current Year - Debits Annual

Current Year - Credits for Period
Current Year - Credits YTD

Current Year - Credits Annual
S

- Prior Year 1

Prior Year 1 - Actual for Period
Prior Year 1 - Actual YTD

Prior Year 1 - Actual Annual

Prior Year 1 - Budget for Period

Prior Year 1 - Budget YTD

Prior Year 1 - Budget Annual

Prior Year 1 - Revised Budget for Period
Prior Year 1 - Revised Budget YTD

Prior Year 1 - Revised Budget Annual
Prior Year 1 - Debits for Period

Prior Year 1 - Debits YTD

Prior Year 1 - Debits Annual

Prior Year 1 - Credits for Period

Prior Year 1 - Credits YTD

Prior Year 1 - Credits Annual

10/18/2023

MB
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Modify Budgeted Financial Format Formulas

Edit Formula Standard

Column Header |[New Formula |

Formula Type @ difference O percent O advanced

Variables | ~ - ~]
e @]

Column Header [New Formula J

Formula Type O difference O percent @ advanced

Insert Field | [4| insertinto Formula

Advanced Formula

Advanced

MB
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Preliminary Budget Report

Report Preferences
* General Ledger > Reports >
FiLTERS OpTiONS
Preliminary Budget
Account Number
Account Structure
* Choose the accounts for =@ A

your report from the Filters. B 1 Crurch
10 Genl Income

20 Personnel
30 Genl Operations
40 Children

50 Youth
60 Adult Groups
70 Warship/Arts

- T ST P

26

10/18/2023
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Preliminary Budget Report

Report Preferences

* Select the Report Options. Furens  Oprions
Change Appearance? v
* Choose your Report Type. Report Options ::::::...:;
[ Show Note Information?

* Drag and Drop the columns Wiap Account Descrption?

Print In Landscape?

tt . Use Revised Budget for Prior Year?
you wan o appear n Page Break Options ) none @ Department Name
Report Type
> ‘Summary
your repo rt. — Available Options: _Iyet3il (Month By Month) | SIS
Act Total Lines Only |
| Detail (Actual vs. Proposed Budget) ‘
| Detail (Budget vs_Proposed Budget)

* Export to Excel or Print.

a

* Click Run.

Export Option @ None O Excel of—

27
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Preliminary Budget Report — Detail or Summary

Advance Your Knowledge

Preliminary Budget Report for Period 1 - July
Detail (Actual vs. Proposed Budgst) Report
Company#: 1 Name: First Church

Fiscal Year Beginning 7/1/20

Fund Name: 1 Church
Department Name: 30 Genl Operations

52310 Printing/ copter
July

August

September

Octaber

November

December

January

February

March

April

May

June

Audit

Total 52310 Printing/copier

e

Preliminary Budget Report for Period 1 - July
Summary

Report
Company#: 1 Name: First Church

Fund Name: 1 Church
Department Name: 30 Genl Operations

Fiscal Year Beginning 7/1,
Prioc Prior Year Pronosed

Budget Actual Budeet
OPERATING EXPS
GENERAL EXPS
52110 Accountant/Audit $12,000.00 $5,825.00 $12,000.00
52115 Advertising/marketing $9,600.00 $6,600.00 $9,600.00
52130 Bank Fees $300.00 $115.00 $300.00
52160 Computer Supplies $1,800.00 $930.08 $1,800.00
52190 Insurance-property & liability $13,500.00 $9,000.00 $13,500.00
52220 Legal Fees 5$1,200.00 $0.00 $1,200.00
52250 Office Supplies $3,200.00 $0.00 $3,200.00
52280 Postage/shipping $15,000.00 $4,665.00 $15,000.00
52310 Printing/copier 5§7,700.00 $8,075.04 $7,700.00
52340 Supplies $1,200.00 $337.09 $1,200.00
Total GENERAL EXPS $65,500.00 $35,547.21 $65,500.00
FACILIIES £XPS mas

10/18/2023

MB
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Financial Spreadsheet

Advance Your Knowledge

Prefer to run in Excel.

Remember to choose the Ending Period. Audit

Period if your setup for 13 periods.

When the "Use Actuals for Closed Periods" is
selected, this report will place the actuals amounts
for Income/Expense in the period fields and will
place the budget amount in the remaining

periods. This is a great forecasting tool based on

actual amounts in the past and budget amounts

for the future.

Home = General Ledger = Reports = Financial Spreadsheet

Report Preferences

FiLTers OpTIONS
Change Appearance? O/ Trebuchet MS ~ | 8pt v | 100% v
Ending Period d—
Report Type () Actual @ Budget () Revised Budget

Use Actuals For Closed Periods?
Report Options & Suppress Zero Balances?
] Wrap Account Description?
Use Reverse Signs?
Show Whole Dollars Only?
(] Show Sub Accounts?

Line Spacing

Page Break Options ® None () Department Name
Print Format @ Wide O Narrow
Export Option () None O CSV @ Excel
LSRN CleorPreferences Cancel

10/18/2023

MB
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vance Yo

Knowledge

Financial Spreadsheet

Financial Spreadsheet from July - Audit
[Company: 1 First Church
Budget Figures Report
Accou
Fund Dept Number Description uly August September October November December uary Febru: March  April May Jul Audit Total
20 50000 PERSONNEL
20 50000 SALARIES
1 20 50110 50110 Pastoral Salaries 583332 583322 582332 583332 583332 58332 800000 800000 800000 300000 £000.00 800000 000  82999.92
1 20 50120 50120 Pastoral Housing 3,833.34 383334 3,833.34 383334 3,833.34  3,83334 1333333 1333333 13,333.33 13,333.33 1333333 13,3333 000 103,000.02
1 20 50130 50130 Administration Support 5,886.66  5,886.66 588666 588666 588066 588666 633333 633333 633333 633333 633333 633333 000 73,319.94
1 20 50140 50140 Directors 8,833.30 | 8833.34 883334 883334 883334 88334 10000.00 10,000.00 10,000.00 10,000.00 10,000.00 10,000.00 0.00 113,000.08
1 20 50150 50150 Facilities 3,480.00  3,480.00 3,450.00  3,480.00 348000 348000 750000 7,500.00 7,500.00 750000 7,500.00 7,500.00 0.00 65,880.00
1 20 50160 50160 Nursery Workers 1,02000  1,020.00 1,020.00  1,020.00 1,02000  1,02000 233333 333333 3,333.33 323333 233333 3,333.33 000 26119.98
20 50592 TOTAL SALARIES 23,836.66 28886.66  28,886.66 28,8%6.66  23,886.66  28,886.66 48,499.99 43,99.99 4849999 45,499.99 45,499.99 48,499.99  0.00 464,319.90
20 50610 BENEFITS
1 20 50610 50610 Auto Allowance (Pastors) 74166 7AL66 74166 74166 74166 7AL66  450.00 45000 450.00 45000  450.00  450.00 000  7,149.96
1 20 50620 50620 Cell Allowance 85.00 85.00 8500 85.00 85.00 8500 200.00 20000 20000 20000 20000  200.00 000  1,710.00
1 20 50630 50630 Health/Dental 4,775.00  4,775.00 477500 477500 477500 477500 583333 583333 583333 583333 583333 583333 000  63,649.98
1 20 50635 50635 Continuing Ed/Conferences 0.00 0.00 0.00 0.00 0.00 0.00  1,800.00 0.00 0.00 0.00 000 260000 000 440000
1 20 50640 50640 Payroll Taxes 147034 147034 147034 147038 147034 147034 233333 233333 2,333.33  2,333.33 233333 233333 000 2282202
1 20 50650 50650 Retirement-matching 24050 240.50 24050 240.50 240.50 24050 700.00 70000 700.00 70000 70000  700.00 0.00  5642.00
1 20 50660 50660 Social Security Allowance (Pastors)  £12.92  812.92 81292 81292 212.92 81292 1,633.33 163333 163333 163333 163333 163333 000 14,6750
1 20 50670 50670 Worker Compensation Ins 0.00 0.00 0.00 0.00 0.00 0.00 0.00 000 1,500.00 0.00 000  1,500.00 0.00  3,000.00
20 50992 TOTAL BENEFITS 812542 8125.42 812542 812542 812542 812542 12949.99 11,149.99 12,649.99 11,149.99 11,149.99 15249.99 000 123,052.46
20 50996 TOTAL PERSONNEL 37,01208 37,012.08  37,01208 37,01208 3701208 3701208 61,449.98 59,649.98 61149.38 59,649.98 59,649.98 63,749.98 0.00 587,372.36
0 50000 OPERATING EXPS
J—y conon) . e i o P e NI PPN AT i TN e N e Pl PNt o]

MB
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Advance Your Knowled

Budget Comparison Widget

'amegnc:ompamcmmranE:(pnm.u\eeoum:l.&j A— — 5ot fccounts | Remresn |

$350,000.00 52.500,000.00
$300,000.00

$2.000.000 00
$250,000.00
20000000 $1,500,000.00
$150,000.00

'§100,000.00
$500,000.00 o
$50,000.00
50.00 5000
i RN L
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Advance Your Knowledge

Budget Revisions

Home = General Ledger = Budget Information

Filters

T

Y

wnt o
Department E{‘“\
Account Range |MNo Groups Found v l

Budget Revision

Show Inactive Accounts [

: Resetor Cance

(. e HEE W P -

5 Movember

v 4

PN

Either from an increase

or decrease of

income, organizations are
required to revise their
budget mid-year. You can do
that in Financials by selected
the period to start the revised
budget, and then enter the
amounts or use the
Adjustment % fields to have
the system calculate the
budget for the periods for the
rest of the year.

MB
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Budget Revisions

Home > General Ledger > Budget Information > Update

[ * The benefit of using the
Adjustment 3¢ [ 150 00%)| Using |Revised Sudget v | (ST revised budget is that you can
Aanual Amount . ..
retain the original budget

W M m S while still having access
mﬂ::: ‘ "“"’“ to the updated budget.
August $100.00 2
* Select the period that
—— I you would like the
et s budget revisions to begin on
e the Budget
T Information Screen
[ $150.00| 938
Total: §1,600.00 100.00

33
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Revisions using Budgeted Financial Reports

Home = General Ledger = Budgeted Financial Formats

Add New Template  Make a Copy

* Title |Revised Budget J

Password For Changes. | | retype
Available Columns Selected Columns
[ Account Information Column Header (Editable) Description
= Current Year * O |eudget for Period Current Year - Budget for Period

Current Year - Budget YTD * O |Revised Budget for Period Current Year - Revised Budget for Period
Current Year - Budget Annual O Jactual for Period Current Year - Actual for Period
Current Year - Revised Budget Annual * | Q| JActual YTID Current Year - Actual YTD
Current Year - Debits for Period ? | © | |Revised Budget VTD Current Year - Revised Budget VIO
Current Year - Debits YTD 7 O actusl Annusl Current Year - Actual Annual

Current Year - Debits Annual Page siz: (100~ 6 items in 1 pages

Current Year - Credits for Period
Current Year - Credits YTD

Current Year - Credits Annual

MB
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Account #
Description

Utility Expenses
60310 Utilities-Electric/Gas
60330 Utilities-Telephone
60380 Utilities-Waber/Sewer
60410 Security System

Total Utility Expenses

TOTAL FACILITIES EXPS

35

Revisions using Financial Spreadsheet

Budget for Period Revised Budget for

Actual for Period

10/18/2023

Actual YT Revised Budget YTD

Period
100.00 100,00 00 00 500,00
10.00 10,00 00 00 50.00
2,000.00 2,000.00 .00 00 10,000.00
100.00 150.00 .00 250.00 550.00
2,210.00 2,260.00 .00 250.00 11,100.00
2,210.00 1,260.00 .00 750.00 11,100.00

MB
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Advance Your Knowledge

Variable Budget Accounts — What If?

* On the Budget
Grid, check beside all
accounts you want to be

Variable Accounts.

* Allows you to adjust the

variable up or down by a

percentage.

36
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[ View Selected

Account History Column Options

523 Resource Material

Expense

by Period

§00.00

(] Account# Name Account Type Distribution Type Current Budget History VE
0O 43110 Activities Income by Period 5215000 o
0O 43140 Campsfretreats Income by Period $37,000.00 o
0O D 43100 ves Income by Period $7,70000 o
O 43200 AWANA Income by Period $3325.00 o
O 52140 Checkin Expense Annual $840.00 o (=]
O W 52170 Curriculum/study books | Expense by Period $3,40000 o [m]
O @ 52230 Ministry contacts/gifts Expense Annual $600.00 o
O 52260 Nursery Supplies Expense Annual $3,200.00 tol (m]
O W 52270 OQutreach Expense by Period $1,20000 o =]
O 52280 Postage/shipping Expense Annual $300.00 (ol
0O 52310 Printing/copier Expense Annual $1,38000 T

MB
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Variable Budget Accounts — What If?

Report Preferences

FiLTERS OpTiONS

Change Appearance? [_| Trebuchet S ~ |6

Report Name |Budgeted Financial Statement |

Report Template | Leadership Monthly Budget Report Vl

[ Select Different Starting Period for Fiscal Year?
Reporting Period
Report Type
Adjust Variable Budgets ® Yes (O No b A —

Report Options [ Show Missing Budget as (-) Value? 1]
Suppress Zero Balances?
[ Print Percent of Year Completed In Heading?
Show Sub Accounts?

Print Whole Dollars?
L pmenemn, e, -

MB
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Ministry Brands:

Thank You for Attending

38
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